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1. INTENDED USE

The BD OneFlow™ ALOT (Acute Leukemia Orientation Tube) is intended for in vitro diagnostic use for
qualitative flow-cytometric immunophenotyping of immature hematopoietic cell populations (lymphoid and
myeloid lineages) on a BD flow cytometer equipped with:

o A 488-nm blue laser, a 640-nm red laser, and a 405-nm violet laser

o The ability to detect forward scatter (FSC) and side scatter (SSC)

o At least eight-color fluorescence

« Software to acquire and analyze the data

BD OneFlow™ ALOT is used as an aid in the screening of hematologically abnormal patients having, or
suspected of having, acute lymphoblastic leukemia or acute myeloid leukemia. BD OneFlow™ ALOT can be
used with peripheral whole blood and bone marrow specimens collected in EDTA or heparin. The results
should be interpreted by a pathologist or equivalent professional in conjunction with other clinical or
laboratory findings.

Specific antigens contained in BD OneFlow™ ALOT are listed as follows:

Tube FITC PE PerCP-Cy5.5 PE-Cy7 APC APC-H7 V450 V500-C

ALOT cyMPO® cyCD79a CD34 CD19 CD7 cD3 cyCD3 CD45

a. cy refers to cytoplasmic

2. SUMMARY OF THE TEST

Acute leukemias are a heterogeneous group of diseases characterized as having a clonal (neoplastic)
population of immature hematopoietic cells in the peripheral blood (PB) or bone marrow (BM).! There are two
major classes of acute leukemias: lymphoid precursor leukemias and acute myeloid leukemias (AML). The
lymphoid precursor leukemias are divided into B-cell and T-cell precursor lymphoblastic leukemias (BCP-ALL
and T-ALL, respectively). In addition, a small number of neoplasms do not fit into any of these categories
because they either show no clear expression of markers indicative of a particular lineage, or they express
markers specific to more than one lineage. They include acute undifferentiated leukemia (AUL) and mixed
phenotype acute leukemia (MPAL).

The sample acquisition can be automated using the optional BD FACS™ Universal Loader when used with the
BD FACSLyric™ flow cytometer. This assay is not for automated sample preparation. Data analysis can be
performed using a pre-defined template and gating, however, reviewing all plots and adjusting gating
manually by the user are recommended.



Principle of Operation

The reagent tubes that comprise BD OneFlow™ ALOT are composed of monoclonal antibodies, each
conjugated to a specific fluorochrome. The specimen is added to the reagent tube and incubated, allowing
each fluorochrome-conjugated monoclonal antibody in the reagent to bind to a specific antigen. After
incubation, the FIX&PERM® Cell Fixation and Permeabilization Kit is used to fix the stained cells in suspension
and to permeabilize the cell membranes. Cells are acquired on a BD flow cytometer using the instrument
software. During acquisition, the cells travel past the laser beam and scatter the laser light. The stained cells
fluoresce. These scatter and fluorescence signals, detected by the instrument, provide information about the
cell’s size, internal complexity, and relative fluorescence intensity. The instrument software is used to analyze
the data and report the result.

3. REAGENT

Reagent Composition

BD OneFlow™ ALOT consists of two single-use tubes containing fluorochrome-conjugated antibodies in an
optimized dried formulation. The BD OneFlow™ ALOT (S) tube contains antibodies that recognize cell surface
antigens, and the BD OneFlow™ ALOT (C) tube contains antibodies that recognize cytoplasmic antigens. All of
the antibodies have IgG4 heavy chains and kappa light chains. The antibody clone names are shown beneath
the antibody.

Table 1 Antibody composition of BD OneFlow™ ALOT

Reagent FITC PE PerCP-Cy5.5 PE-Cy7 APC APC-H7 V450° V500-C°
ALOT (S) - - CD34 CD19 CcD7 CD3 - CD45
(8G12)> (5125-C1)** | (M-T701)° | (SK7)®7 (2D1)8°
ALOT (C) cyMPO CD79a - - - - CD3 -
(MPO-7)"° | (HM57)" (UCHT-1)%"
a. BD Horizon™ V450, BD Horizon™ V500-C

The antibodies in the BD OneFlow™ ALOT tubes were chosen for their ability to identify and characterize
aberrant immature populations of hematopoietic cells.

Refer to the article describing the EuroFlow antibody panels' for a full description of the utility of the

antibodies chosen for the reagent tubes.

Precautions

e The reagent tubes contain 0.70% 2-methyl-4-isothiazolin-3-one (CAS number 2682-20-4). These reagents
are classified as hazardous according to the Globally Harmonized System of Classification and Labelling of
Chemicals (GHS) and Regulation (EC) No 1272/2008.



Warning

H317: May cause an allergic skin reaction.

H412: Harmful to aquatic life with long lasting effects.

Prevention P261: Avoid breathing dust/fume/gas/mist/vapors/spray.
P272: Contaminated work clothing should not be allowed out of the workplace.
P273: Avoid release to the environment.

P280: Wear protective gloves/protective clothing/eye protection/face protection.

Response P302+P352: IF ON SKIN: Wash with plenty of water/...
P333+P313: If skin irritation or rash occurs: Get medical advice/attention.

P362+P364: Take off contaminated clothing and wash it before reuse.

Disposal P501: Dispose of contents/container to an appropriate treatment and disposal facility in
accordance with applicable laws and regulations, and product characteristics at time of disposal.

¢ Go to regdocs.bd.com/regdocs/sdsSearch to download the Safety Data Sheet.

Storage and Handling

o Store tubes at 2-27 °C in the foil pouch.

« Do not freeze the reagent or expose it to direct light at any time during storage or incubation with cells.

e The dried fluorochrome-conjugated antibodies are stable until the expiration date shown on the pouch and
tube labels when stored as directed. Do not use after the expiration date.

e Once the pouch is opened, the dried fluorochrome-conjugated antibodies are stable for one month when
stored as directed.
CAUTION Ensure the pouch is completely resealed after removing a tube. The reagent is very sensitive to
moisture. Do not remove the desiccant from the reagent pouch.

4. INSTRUMENTS

The recommended BD systems are outlined. See the following table. See the corresponding reagent or
instrument user documentation for details.

Table 2 Recommended BD systems

Flow cytometer Setup beads Setup software Analysis software
BD FACSLyric™® BD® CS&T Beads BD FACSuite™ Clinical BD FACSuite™ Clinical
BD® FC Beads 7-Color Kit application v1.4 or later” application v1.4 or later

BD® FC Beads 5-Color Kit

BD® FC Beads 2-Color Kit (12-
color instrument)

BD FACSCanto™ II° | BD FACSDiva™ CS&T IVD BD FACSDiva™ software v8.0.1 | BD FACSDiva™ software
Beads or later v8.0.1 or later

BD OneFlow™ Setup Beads

BD FC Beads 8-Color Kit for
BD OneFlow™ Assays

a. 8-color (4-Blue 2-Red 2-Violet), 10-color (4-Blue 3-Red 3-Violet), or 12-color (4-Blue 3-Red 5-Violet)




Flow cytometer Setup beads Setup software Analysis software

b. The Loader can be used with BD FACSuite™ Clinical application v1.5 or later
c. 3-laser, 8-color, 4-2H-2V BD default (4-2H-2V) optical configuration

The BD FACS™ Universal Loader can be used with these products. See the BD FACSLyric™ System Instructions
For Use for more information. The Loader can be used with BD FACSuite™ Clinical application v1.5 or later.

5. SPECIMEN COLLECTION AND PREPARATION

BD OneFlow™ ALOT can be used for immunophenotyping by flow cytometry of peripheral blood (PB) or bone
marrow (BM) aspirates.

¢ (Collect PB specimens aseptically by venipuncture in BD Vacutainer® K2 or K3 EDTA blood collection tubes,
or equivalent, or in lithium or sodium heparin.”

¢ (Collect BM specimens in BD Vacutainer® K2 or K3 EDTA blood collection tubes, or equivalent, or in lithium
or sodium heparin.
We recommend that you follow guidelines described in consensus protocols for flow cytometric
immunophenotyping of hematopoietic malignancies.“"15

* Specimens should be processed up to 24 hours after collection.

Specimens with large numbers of nonviable cells can give erroneous results due to selective loss of
populations and to increased nonspecific binding of antibodies to nonviable cells. Viability of specimens
should be assessed. A minimum viability of 75% is recommended."®

o Samples should be acquired within 60 minutes of staining if kept at room temperature, protected from
light.
WARNING All biological specimens and materials coming in contact with them are considered biohazards.
Handle as if capable of transmitting infection'”"® and dispose of with proper precautions in accordance
with federal, state, and local regulations. Never pipette by mouth. Wear suitable protective clothing,
eyewear, and gloves.

Interfering Conditions

Substances present in the specimen might interfere with the assay:

o Use of therapeutic monoclonal antibodies in patient treatment, such as Rituximab and Alemtuzumab, can
interfere with recognition of target antigens by this reagent or deplete the clinically relevant cell
populations. This should be considered when analyzing samples from patients treated in this fashion.

BD Biosciences has not characterized the effect of the presence of therapeutic antibodies on the
performance of this reagent.

« Avoid using potentially compromised specimens, including clotted, hemolyzed, frozen, or refrigerated
specimens.

The table lists the substances that were tested for interference with BD OneFlow™ ALOT.

Testing for interference was performed in accordance with CLSI guidelines.19 There was no detectable
interference at the following concentrations.

Table 3 Test concentrations for exogenous interferents

Exogenous interferent Concentration tested
Acetaminophen 0.156 mg/mL
Acetylsalicylic acid (Aspirin) 0.03 mg/mL




Exogenous interferent

Concentration tested

Albuterol 0.000045 mg/mL
Guaifenesin 0.0045 mg/mL
Ibuprofen 0.219 mg/mL

Oseltamivir phosphate

0.000399 mg/mL

Table 4 Test concentrations for endogenous interferents

Endogenous interferent

Highest expected concentration

Hemoglobin or hemolysate 10 mg/mL
Albumin or total protein 60 mg/mL
Bilirubin, conjugated 0.4 mg/mL
Bilirubin, unconjugated 0.4 mg/mL
Triglycerides 15 mg/mL
Erythrocytes 6x10° cells/plL

6. PROCEDURE
Reagents and Materials

Reagents and materials provided

BD OneFlow™ ALOT is provided as single-use tubes in foil pouches. Each kit contains four pouches:

 two pouches, each containing five tubes of BD OneFlow™ ALOT (S)
« two pouches, each containing five tubes of BD OneFlow™ ALOT (C)

Reagents and materials required but not provided

For BD FACSLyric™ flow cytometers:

* BD OneFlow™ Assays Installer IT (Catalog No. 664226)

An installer is required for the BD OneFlow™ ALOT assay. If you are using the Loader, use BD OneFlow™
Assays Installer I v1.1 to install the assay in BD FACSuite™ Clinical application v1.5 or later. The assay
comprises an acquisition sheet, a laboratory report, a physician report, and a supplemental report used for
further investigation. Unless you already have the current BD OneFlow™ ALOT assay, you will have to order

the installer for BD OneFlow™ Assays the first time you order BD OneFlow™ ALOT.

The BD OneFlow™ Application Guide for Acute Leukemias for BD FACSLyric™ Flow Cytometers is provided

with the installer.

For BD FACSCanto™ II flow cytometers:

e BD OneFlow™ Assay Templates Installer (Catalog No. 659305)

An installer is required for the BD OneFlow™ ALOT template. The template contains two global worksheets:
the BD OneFlow™ ALOT Acquisition worksheet and the BD OneFlow™ ALOT Analysis worksheet. Unless you




already have the current BD OneFlow™ ALOT template, you will have to order the installer the first time
you order BD OneFlow™ ALOT. The installer also contains the BD OneFlow™ Setup template and templates
for other BD OneFlow™ reagents.

The Instrument Setup Guide for BD OneFlow™ Assays and the BD OneFlow™ Application Guide for Acute
Leukemias are provided with the installer.

15-mL conical polypropylene tubes

40-pum cell strainer (if needed for processing BM specimens)

Pasteur pipet

Serological pipet

Micropipettor with tips

Vortex mixer

Centrifuge

Wash buffer (filtered phosphate buffered saline (PBS) + 0.5% bovine serum albumin (BSA) + 0.09% or 0.1%
sodium azide)

« FIX&PERM® Cell Fixation and Permeabilization kit

o (Optional) BD FACS™ Universal Loader
NOTE Labs must validate any deviations from the following procedures.

Installing the Assay or Template

The BD OneFlow™ Assay Installer, used with BD FACSuite™ Clinical application, or the BD OneFlow™ Assay
Template Installer, used with BD FACSDiva™ software, has to be installed before you run the assay for the
first time. Additional assays or templates can be installed at the same time, as needed. If you will analyze the
FCS files on a different workstation from the one used to acquire the samples, ensure that you install the
assays or templates on both workstations.

To install the BD OneFlow™ assay in BD FACSuite™ Clinical application:

NOTE When you select an assay to install, it will overwrite the BD OneFlow™ assay that was previously
installed on the system. If you do not want an existing assay on your computer to be overwritten, do not
select that assay from the installer during the installation process.

1. Insert the installer and click the installer icon.
The InstallShield Wizard for BD OneFlow™ Assays opens.
2. Click Next.

The license agreement opens.

3. Select the I accept the terms in the license agreement option and click Next.
4. To install all of the assays included on the installer, select the Complete option and click Next.

5. Optional: To install a subset of the assays included on the installer, select the Custom option and click
Next.

The Custom Setup dialog opens.

o Click the menu to the left of the appropriate assay.
o From the menu, select This assay will be installed on your local hard drive.

6. Click Install.

The assays will be installed in the Library.
7. Click Finish.

The InstallShield Wizard closes.
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10.

Optional: Double-click the ReadMe file found on the installer.

The ReadMe file opens.

Click the close box when finished reading it.
Remove the installer.

To install the OneFlow template in BD FACSDiva™ software:

NOTE When you select a template to install, it will always overwrite any template with the same name that
was previously installed on the system. If you do not want an existing template on your computer to be
overwritten, do not select that template from the installer during the installation process.

1.
2.

3,
4,
5.

Insert the installer and click the installer icon.
Follow the instructions in the dialog.

The installer will copy and paste the templates in the folder D:\BDExport\Templates\Panel\BD Panels.
NOTE If your system has only one drive, the templates will be installed in

C:\BDExport\Templates\Panel\BD Panels.

After installation is complete, a dialog opens, summarizing which templates have been successfully copied
into the folder.

Click OK to close the dialog.
The installer ReadMe file opens. Click the close box when you have finished reading it.
Remove the installer.

Setting up the Cytometer

For BD FACSLyric™ flow cytometers:

1.

Use BD® CS&T Beads and BD FACSuite™ Clinical application v1.4 or later, to perform Characterization QC
(CQQ) every 6 months or as needed, perform daily Performance QC (PQC), and perform daily assay and
tube settings setup. For assay and tube settings setup, select the Run Setup and Generate Reports
checkboxes.

Use the BD® FC Beads 7-Color Kit, BD® FC Beads 5-Color Kit, and BD FACSuite™ Clinical application v1.4 or
later, to update reference settings every 60 days. In addition, use the BD® FC Beads 2-Color Kit to set up a
12-color instrument.

See the BD FACSLyric™ System Instructions For Use, the BD FACSLyric™ Clinical Reference System, and the
appropriate reagent IFU for more information.

For BD FACSCanto™ II flow cytometers:

1.

2.

Use BD FACSDiva™ CS&T IVD Beads (CS&T IVD beads) and BD FACSDiva™ software v8.0.1 or later, to
define the baseline of the cytometer and to run a daily performance check of the cytometer.

Use BD OneFlow™ Setup Beads, lysed washed blood, and BD FACSDiva™ software v8.0.1 or later, to set
photomultiplier tube (PMT) and scatter voltages monthly.

3. Use BD® FC Beads and BD FACSDiva™ software v8.0.1 or later, to set fluorescence compensation monthly.

4. We recommend that you confirm that the PMT voltages (PMTVs) are still within their daily target ranges.

See the Instrument Setup Guide for BD OneFlow™ Assays and the appropriate reagent IFU for more
information.

Staining the Specimen

NOTE Before staining the specimen, confirm that the cytometer has been properly set up.



10.
11.
12.
13.

14.
15.

16.
17.
18.
19.
20.

21.

22.

. If the pouches are stored refrigerated, allow them to reach room temperature before opening them.

NOTE The reagent is very sensitive to moisture. To avoid condensation, open the pouches only if they are
at room temperature.

For each patient specimen, remove a BD OneFlow™ ALOT (S) tube from its pouch. Do not remove the

BD OneFlow™ ALOT (C) tube from its pouch at this time.

Place the tubes in a rack, protected from light.
Start staining the specimen within one hour of removing a tube from the pouch.
Immediately reseal the pouch with any unused tubes.

NOTE Ensure that the pouch is completely resealed after removing a tube. The reagent is very sensitive to
moisture. Do not remove the desiccant from the reagent pouch.

The reagent is very sensitive to light. Start staining the specimen immediately.
Write the patient ID on the tube label within the area provided.

NOTE Write the current date on the pouch label when it is first opened. Use the tubes from that pouch
within one month before opening the next pouch.

Prepare each specimen as described:
* For PB specimens, invert the collection tube 10 times to mix well.

* For BM specimens, invert the collection tube 10 times to mix well. Verify that the specimen is not lipemic
and does not have particulate matter in it.

—If needed, pass sufficient specimen through a 40-um cell strainer.
Add 50 pL of wash buffer and 50 pL of unwashed specimen to the BD OneFlow™ ALOT (S) tube.

NOTE Staining from 5 x 10° to 4 x 10’ white blood cells/mL gives equivalent results.

Vortex vigorously 3-5 seconds to mix well.

Incubate for 30 minutes at 20-25 °C, protected from light.

Add 1.5 mL of wash buffer. Vortex vigorously 3-5 seconds to mix well.

Add an additional 1.5 mL of wash buffer. Vortex gently to mix.

Centrifuge at 540g for 5 minutes at 20-25 °C.

Remove the supernatant without disturbing the cell pellet, leaving approximately 50 pL of residual liquid
in the tube.

Vortex vigorously until the cell pellet is completely resuspended.

Add 100 pL of FIX&PERM Reagent A (fixation solution) to the tube. Vortex vigorously 3-5 seconds to mix
well.

Incubate for 15 minutes at 20-25 °C, protected from light.

Add 1.5 mL of wash buffer. Vortex vigorously 3-5 seconds to mix well.

Add an additional 1.5 mL of wash buffer. Vortex gently to mix.

Centrifuge at 540g for 5 minutes at 20-25 °C.

Remove the supernatant without disturbing the cell pellet, leaving approximately 50 pL of residual liquid
in the tube.

Vortex vigorously until the cell pellet is completely resuspended.

NOTE If you are unable to obtain a single-cell suspension, see Troubleshooting.
Measure the volume in each tube using a pipet and add wash buffer to give a final volume of 100 plL in
each tube. Vortex 3-5 seconds to mix well.

NOTE It is important to have a final volume of 100 pL in each tube so that all of the cells will be
completely permeabilized in steps 25-28.



23.

24,

25.
26.

27.
28.
29.
30.
31.
32.

33.
34.

Remove the appropriate number of BD OneFlow™ ALOT (C) tubes from the pouch and reseal the pouch
immediately.

NOTE Ensure that the pouch is completely resealed after removing a tube. The reagent is very sensitive to
moisture. Do not remove the desiccant from the reagent pouch.

Write the patient ID on the BD OneFlow™ ALOT (C) tube label within the area provided.

NOTE Write the current date on the pouch label when it is first opened. Use the tubes from that pouch
within one month before opening the next one.
Add 100 pL of FIX&PERM Reagent B (permeabilization solution) to the BD OneFlow™ ALOT (C) tube.

Transfer 100 pL of the sample from the BD OneFlow™ ALOT (S) tube to the corresponding BD OneFlow™
ALOT (C) tube.

NOTE Make sure that the patient ID numbers on the two tubes are the same.

Vortex the BD OneFlow™ ALOT (C) tube vigorously 3-5 seconds to mix well.

Incubate for 15 minutes at 20-25 °C, protected from light.

Add 1.5 mL of wash buffer. Vortex vigorously 3-5 seconds to mix well.

Add an additional 1.5 mL of wash buffer. Vortex gently to mix.

Centrifuge at 540g for 5 minutes at 20-25 °C.

Remove the supernatant without disturbing the cell pellet, leaving approximately 50 pL of residual liquid
in the tube.

Vortex 3-5 seconds to resuspend the cell pellet.

Add 250 plL of wash buffer to the tube to give a final volume of 300 pL. Vortex 3-5 seconds to mix well.

NOTE Samples should be acquired within 60 minutes of staining if kept at room temperature, protected
from light.

Setting up the Assay (BD FACSLyric™ Flow Cytometer)

To add a reagent lot ID and expiration date to the library:

1.

From the BD FACSuite™ Clinical application navigation bar, click the Library icon.

The Library workspace opens.

Expand the Beads and Reagents menu and select Reagents.
Select OneFlow ALOT from the Product Name list.

The OneFlow ALOT pane opens at the bottom of the page.
Click Add Lot.
The Add New Lot dialog opens.

In BD FACSuite™ Clinical application v1.5, click Scan Barcode and then scan the barcode on the pouch or
tube label.

The Lot ID and expiration date are entered in the appropriate fields.

Make sure to add the Lot ID and expiration date for both tubes, BD OneFlow™ ALOT (S) and BD OneFlow™
ALOT (C).

NOTE In BD FACSuite™ Clinical application v1.4, add the Lot ID and expiration date manually.
Select the Current Lot checkbox.
Click OK.

The lot ID and expiration date are added to the appropriate columns for the reagent.



NOTE Make sure to add the reagent lot and expiration date prior to acquisition. This has to be done only
once for a particular reagent lot.

To create a worklist:

1.

5w

From the BD FACSuite™ Clinical application navigation bar, click the Worklists icon.
The Worklists workspace opens.
In the Manage Worklists tab, click New.

A blank worklist opens in a new tab.

In the Worklist Entries section, select the appropriate task from the Task menu.
Enter the Sample ID for BD OneFlow™ reagent tasks.

Do not scan the barcode, found on the tube label, into the software.

NOTE Multiple lots of reagent cannot be run on the same worklist.
In the Loading Options section, select Manual from the Loading Option menu.

See the BD FACSLyric™ System Instructions For Use for more information.

Setting up the Experiment (BD FACSCanto™ II Flow Cytometer)

1.

From the menu bar, select Edit > User Preferences, then navigate to the FCS tab, and select Export FCS
after recording, to automatically export the FCS files after acquisition. Click OK.

2. Confirm that the cytometer is in the 4-2H-2V BD default configuration.

3. From the menu bar, select Experiment > New Experiment > Blank Experiment. Click OK.

o ve

10.
11.

12.

13.
14.

15.

NOTE You can also create an experiment directly from the Browser using the Experiment icon.

If prompted by the CST Mismatch dialog, select Use CST Settings.
Rename the experiment according to your laboratory practice.

. In the Browser, right-click Cytometer Settings > Link Setup and select the appropriate compensation

matrix calculated using BD® FC Beads within the past 31 days. Click Link.

See the BD® FC Beads 8-Color Kit for BD OneFlow™ Assays IFU or the Instrument Setup Guide for
BD Oneflow™ Assays.

If prompted by the Cytometer Settings Mismatch dialog, select Overwrite.

Right-click Cytometer Settings > Unlink From and select the previously linked compensation setup. Click
OK.

NOTE Unlinking the compensation setup allows updated application settings to be applied while
retaining compensation values.

In the Browser, right-click Cytometer Settings > Application Settings > Apply and select the most recent
application settings determined within the last 31 days using the BD OneFlow™ Setup Beads. Click Apply.
A Confirm dialog opens. Select Keep the compensation value.

If prompted by the Confirm Cytometer Changes dialog, click Yes to overwrite the cytometer values for
FSC Area Scaling.

From the menu bar, select Experiment > New Specimen.
The Panel Templates dialog opens.

Navigate to the BD Panels tab and select the OneFlow ALOT template.

Indicate the number of patient specimens you want to acquire using the Copies field near the bottom of
the BD Panels tab. Click OK.

Rename each specimen, for example, with the appropriate patient ID in front of the specimen name.

10



16.
17.

18.
19.

NOTE If you have to re-run a particular patient sample, set the current tube pointer to the tube you wish
to re-run. Click Next Tube in the Acquisition Dashboard to create another tube for that patient. Do not
select Experiment > New Tube from the menu bar or use the New Tube icon from the Browser menu bar
to create the additional tube to be acquired because the labels and barcode fields will not be populated.

NOTE If you want to acquire additional patient samples in the experiment, repeat steps 12-15 to add
new specimens. Two Confirm dialogs will open asking if you want to create another BD OneFlow™ ALOT
acquisition worksheet or another BD OneFlow™ ALOT analysis worksheet. Click Cancel in each dialog.
From the menu bar, select Experiment > Experiment Layout and navigate to the Keywords tab.

Highlight the Product ID keyword for the appropriate tube, and scan the barcode on the BD OneFlow™
ALOT (C) tube label.

NOTE If you cannot scan the barcode on the tube label, see Troubleshooting on page 23.

Manually add the appropriate information to the remaining keywords, as needed.
Click OK to close the Experiment Layout.

Acquiring the Stained Sample

For BD FACSLyric™ flow cytometers:

Two versions of the assay are available:

Assay version Software Stopping time Acquisition mode
v1.0 BD FACSuite™ Clinical application v1.4 or later 5 minutes Manual
v1.1 BD FACSuite™ Clinical application v1.5 or later 3 minutes Manual, Loader

The assay will automatically collect 100,000 total events. You cannot append the number of events to collect
after acquisition has started. Therefore, if needed, change the number of events to collect before you start
acquisition. To change the number of events to collect, see the BD OneFlow™ Application Guide for Acute
Leukemias for BD FACSLyric™ Flow Cytometers. A clinically relevant number of cells can be determined at the
discretion of an appropriate healthcare professional.

To acquire the sample using BD OneFlow™ ALOT assay v1.1:

1.

4,

In the Worklist Controls bar, select Run All from the Run menu to run the entire worklist from the
beginning.

Alternatively, to acquire a specific tube, set the run pointer to the sample you want to run and select Run
from Pointer from the Run menu.

Vortex each stained tube 3-5 seconds at low speed immediately prior to acquisition.

If using the BD FACS™ Universal Loader, vortex tubes immediately before placing them in the Loader
racks.

NOTE Make sure that all of the BD OneFlow™ tubes in the rack are acquired within 1 hour. If not, you
must validate tubes acquired outside the 1 hour time.

Follow the prompts in the software to load or unload tubes.

The BD OneFlow™ ALOT Acquisition sheet opens. The acquisition sheet contains dot plots and gates to
identify Leukocytes, Lymphocytes, B cells, T cells, NK cells, and their relevant subpopulations.

Examine each dot plot on the acquisition sheet.
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NOTE The preview time is 10 seconds and then data is automatically recorded. Do not increase the
preview time and risk loss of the sample due to insufficient volume.

NOTE The assay will automatically collect 100,000 total events. If the assay cannot collect 100,000 total
events, acquisition will stop after 3 minutes. A QC message, “All Events gate does not contain the
requested 100,000 events” is generated in the Lab Report, and can be ignored if the sample can be
analyzed using the events acquired.

See the BD FACSLyric™ System Instructions For Use for more information.

To acquire the sample using BD OneFlow™ ALOT assay v1.0:

1.

In the Worklist Controls bar, select Run All from the Run menu to run the entire worklist from the
beginning.

Alternatively, to acquire a specific tube, set the run pointer to the sample you want to run and select Run
from Pointer from the Run menu.

2. Vortex each tube 3-5 seconds at low speed immediately prior to acquisition.

Follow the prompts in the software to load or unload tubes.

The BD OneFlow™ ALOT Acquisition sheet opens. The acquisition sheet contains dot plots and gates to
identify Cells, Leukocytes, and CD45™""™.

Examine each dot plot on the acquisition sheet.

NOTE The preview time is 10 seconds and then data is automatically recorded. Do not increase the
preview time and risk loss of the sample due to insufficient volume.

If it appears that fewer than 100,000 events will be collected, monitor the sample volume and click Stop
Tube in the Worklist Controls bar to stop acquisition before the tube runs dry.

NOTE The assay will automatically collect 100,000 total events. If the assay cannot collect 100,000 total
events, acquisition will stop after 5 minutes. However, make sure you monitor the sample volume and click
Stop Tube in the Worklist Controls bar to stop acquisition before the tube runs dry. To change the
stopping criteria, see the BD OneFlow™ Application Guide for Acute Leukemias for BD FACSLyric™ Flow
Cytometers.

See the BD FACSLyric™ System Instructions For Use for more information.

For BD FACSCanto™ II flow cytometers:

5.

1. Inthe Browser, expand the appropriate specimen and set the current tube pointer to that tube.

2. Select the BD OneFlow™ ALOT Acquisition worksheet tab.

3.

4. Install the tube on the cytometer. Adjust the flow rate to Medium in the Acquisition Dashboard. Click

Vortex the stained tube 3-5 seconds at low speed.

Acquire Data.
Verify that the population is on scale and adjust the gate in the first plot of the acquisition worksheet to
exclude debris, if needed.

Click Record Data in the Acquisition Dashboard to collect total events.
NOTE The template automatically collects 100,000 total events.” Use the menu in the Acquisition

Dashboard to select a different number of events to acquire, if needed. A clinically relevant number of
cells can be determined at the discretion of an appropriate healthcare professional.

Inspect the dot plots on the acquisition worksheet, and adjust the gates as needed.
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Some of the dot plots might look different from those in other experiments. The initial FSC-A vs SSC-A dot
plot to identify cells and eliminate debris may appear compressed. This is a consequence of the target
values used to create the application settings. The values are specified by the EuroFlow Consortium.

NOTE Enlarge the dot plots while adjusting the gates so you can more readily see the populations of
interest. After adjusting the gates, collapse the dot plot to its original size.

The FSC-A vs SSC-A dot plot is used to identify cells.
The CD45 V500-A vs SSC-A dot plot from the Cells population is used to identify leukocytes.

neg/dim

The CD45 V500-A vs SSC-A dot plot from the Leukocytes population is used to identify the CD45
population.

The remaining dot plots do not contain gates and are included to assess staining of the CD45™Y"™

population with all of the antibodies, therefore serving as an internal quality control for the tube.

NOTE See the BD OneFlow™ Application Guide for Acute Leukemias for examples of the dot plots showing
populations of normal cells in the acquisition worksheet.

8. Continue until all of the tubes have been acquired.
9. From the menu bar, select File > Export > Experiments, and select the Directory Export option. Click OK.

Analyzing the Data Using BD FACSuite™ Clinical Application

NOTE FCS files acquired using BD OneFlow™ ALOT assay v1.0 can be opened in BD OneFlow™ ALOT assay
v1.1.

1.

Set the run pointer to the appropriate sample in the Worklist Entries panel.
The BD OneFlow™ ALOT Laboratory Report opens in the Laboratory Report tab.
Review the BD OneFlow™ ALOT Laboratory Report.

The first page of the laboratory report shows sample and tube information, population statistics, and QC
messages, if generated.

NOTE Populations with a low number of events might report %Parent or %Grandparent as 0.0%. This is
due to rounding the result to a single decimal place in BD FACSuite™ Clinical application.

Inspect the dot plots on page 2 of the laboratory report and adjust the gates as needed.

The dot plots on page 2 of the laboratory report provide a high level cell analysis, identifying Cells, FSC
Singlets, SSC Singlets, Leukocytes, and CD45™¥"™ cells.

NOTE Enlarge the dot plots while adjusting the gates so you can more readily see the populations of
interest. After adjusting the gates, collapse the dot plot to its original size.

See the BD OneFlow™ Application Guide for Acute Leukemias for BD FACSLyric™ Flow Cytometers for
examples of dot plots showing populations of normal cells.

Inspect the dot plots on page 3 of the laboratory report and adjust the gates as needed.

The dot plots on page 3 of the laboratory report are used to identify and analyze the T cells and B cells in
the sample.

Inspect the dot plots on page 4 of the laboratory report and adjust the gates as needed.

The dot plots on page 4 of the laboratory report are used to identify and analyze the Non-Lymphoid cells
in the sample.

Inspect the dot plots on page 5 of the laboratory report and adjust the gates as needed.
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10.
11.

12.
13.
14.
15.

16.

neg/dim

The dot plots on page 5 of the laboratory report are used to identify and analyze the CD45 cellsin

the sample.
Inspect page 6 of the laboratory report.

Page 6 of the laboratory report includes lot and expiration dates for BD® CS&T Beads and the
BD OneFlow™ reagent, reference settings, tube settings, and cytometer configuration.

(Optional) Select the Physician Report tab to view the report.
The BD OneFlow™ ALOT Physician Report contains a high level summary of the assay results.
(Optional) Select the Supplemental Report tab to add additional dot plots to further analyze the sample.

See the BD OneFlow™ Application Guide for Acute Leukemias for BD FACSLyric™ Flow Cytometers for more
information.

WARNING Any gated regions deleted in this Supplemental Report are reflected in the Laboratory and
Physician Reports. Any gated regions created in this Supplemental Report might be reflected in the
Laboratory Report.

WARNING Do not add dot plots or gates to the Laboratory Report or Physician Report. They cannot be
deleted and will invalidate the report.

Select the Laboratory Report tab.

Click E-sign.

The E-Signature dialog opens.

Select a user ID.

Type your password.

(Optional) Enter any comments.
Click Sign.

The dialog closes and the signer’s user ID, date and time, and comments are added to the E-signature box
in all three reports.

Click Approve.

The Laboratory and Physicians Reports are automatically exported to C:\BD Export Clinical. If needed,
manually export the Supplemental Report.

See the BD FACSLyric™ System Instructions For Use for more information and export options.

Analyzing the Data Using BD FACSDiva™ Software

1.

From the menu bar, select File > Import > Experiments.

2. Select the experiment that you want to analyze. Click Import.

The experiment with the associated acquisition and analysis worksheets opens.
Select the BD OneFlow™ ALOT Analysis worksheet tab.

Inspect the dot plots on page 1 of the analysis worksheet, and adjust the gates as needed.

Some of the dot plots might look different from those in other experiments. The initial FSC-A vs SSC-A dot
plot to identify cells and eliminate debris may appear compressed. This is a consequence of the target
values used to create the application settings. The values are specified by the EuroFlow Consortium.

NOTE Enlarge the dot plots while adjusting the gates so you can more readily see the populations of
interest. After adjusting the gates, collapse the dot plot to its original size.
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The first three dot plots on page 1 of the analysis worksheet identify cells, FSC singlets, and SSC singlets.
Debris and doublets are excluded by adjusting the gates.

Examine the Leukocytes population in the CD45 V500-A vs SSC-A dot plot from the SSC Singlets gate.
Examine the CD45™Y“™ population in the CD45 V500-A vs SSC-A dot plot from the Leukocytes gate.

The CD34 PerCP-Cy5.5-A vs SSC-A dot plot does not have a gate and is used for informational purposes.
NOTE See the BD OneFlow™ Application Guide for Acute Leukemias for examples of dot plots showing
populations of normal cells in the analysis worksheet.

. Inspect the dot plots identifying T cells on the top half of page 2 of the analysis worksheet, and adjust the

gates as needed.

Cells expressing cytoplasmic CD3 (cyCD3") are identified in the cyCD3 V450-A vs SSC-A dot plot from the
Leukocytes population.

T cells are identified in the CD3 APC-H7-A vs cyCD3 V450-A dot plot from the cyCD3" population. The
cyCD3" cells are characterized in the remaining dot plots.

. Inspect the dot plots identifying B cells on the bottom half of page 2 of the analysis worksheet, and adjust
the gates as needed.

CD19" cells are identified in the CD19 PE-Cy7-A vs SSC-A dot plot from the Leukocytes population.

B cells are identified in the cyCD79a PE-A vs CD19 PE-Cy7-A dot plot from the CD19" population. The
CD19" cells are characterized in the remaining dot plots.

. Inspect the dot plots identifying non-lymphoid cells on page 3 of the analysis worksheet, and adjust the
gates as needed.

Non-lymphoid cells are identified in the CD45 V500-A vs SSC-A dot plot from the NOT(cyCD3" OR CD19")
population.

Cells expressing cytoplasmic myeloperoxidase (cyMPO") are identified in the cyMPO FITC-A vs SSC-A dot
plot from the Non-Lymphoid population. The non-lymphoid cells are characterized in the remaining dot
plots.

neg/dim

. Inspect the dot plots identifying CD45
as needed.

cells on page 4 of the analysis worksheet, and adjust the gates

CD45™Y™ cells are identified in the CD45 V500-A vs SSC-A dot plot from the Leukocytes population.

CD45™Y"™CD34" cells are identified in the CD34 PerCP-Cy5.5-A vs SSC-A dot plot from the CD45"¥ ™
population.

The remaining dot plots present the expression of each of the markers in combination with CD34 for the
CD45™Y“™ population.

. Examine the results in the statistics box on page 5 of the analysis worksheet.

Confirm that all of the keywords are present in the statistics box. If any of the keywords are missing, see
Troubleshooting on page 23.

. Perform further analyses as needed.

NOTE The gates in the dot plots of the analysis worksheet are provided for analyzing normal and
aberrant cell populations in the specimen. Aberrant cell populations will require further analysis.
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11.

12.
13.

7.

Save the BD OneFlow™ ALOT analysis worksheet as a PDF.

NOTE The BD OneFlow™ ALOT analysis worksheet is a global worksheet. Any gates that are adjusted
when analyzing a sample on a global worksheet will be changed in previously analyzed files. Previously
saved PDFs will not change, but if you go back to a previously analyzed global worksheet, you will have to
readjust the gates so they match what they were before.

(Optional) Click Print to print the analysis worksheet.
Analyze the next sample.

RESULTS

Representative Data

See the appropriate application guide to see laboratory reports showing dot plots from a hematologically
normal adult sample stained with each reagent.

For BD FACSLyric™ flow cytometers:

BD OneFlow™ Application Guide for Acute Leukemias for BD FACSLyric™ Flow Cytometers

For BD FACSCanto™ II flow cytometers:

8.

9.

BD OneFlow™ Application Guide for Acute Leukemias
LIMITATIONS

Use of this reagent for diagnostic evaluation of hematologic disorders should be performed in the context
of a thorough immunophenotypic analysis including other relevant markers.

Use of BD OneFlow™ ALOT requires experience with leukemia and lymphoma immunophenotyping and
classification. The results should be interpreted by a pathologist, or equivalent professional, in conjunction
with other clinical or laboratory findings.

BD OneFlow™ ALOT has not been tested on specimens from patients with minimal residual disease (MRD).

PERFORMANCE CHARACTERISTICS

Specimen handling and collection (AOB/AOS)

A study was performed to assess the Age of Blood (AOB) and Age of Stain (AOS) using BD OneFlow™ ALOT.
The stability of EDTA- or heparin-anticoagulated peripheral blood or bone marrow specimens was evaluated
by assessing the combined effect of:

AOB: time duration between specimen collection and staining
AOS: time duration between completion of stained sample processing and acquisition with the flow
cytometer.

Specimens were tested up to 24 hours post collection and stained samples were tested up to 3 hours post
stain. All samples were maintained at room temperature before staining or acquisition.

Based on the results of this study, we recommend staining samples within 24 hours of collection and
acquiring samples within 1 hour of staining if the sample is kept at 20-25 °C.

BD FACSLyric™ Flow Cytometer
Method comparison, BD FACSLyric™ vs BD FACSCanto™ II flow cytometer

A method comparison study between the BD OneFlow™ system on the BD FACSLyric™ flow cytometer
(Investigational Method) and the BD OneFlow™ system on the BD FACSCanto™ II flow cytometer
(Comparator Method) was performed at 3 clinical sites. The BD OneFlow™ system on BD FACSLyric™
comprises BD® CS&T Beads, BD® FC Beads 7-Color Kit, BD® FC Beads 5-Color Kit, and BD OneFlow™ ALOT
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